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The Demonstrating Value Workbook

Introduction
Demonstrating Value can help you take control of the data you collect, how it is used and to
communicate the performance and value of your organization, social enterprise or program. In this
activity guide, you will work out what your data needs are, how they can be met, and how to design
a ‘Snapshot’ that will provide an engaging summary of the performance and value of your
organization.
This process involves the following steps:

Step 1: Define your audiences and their needs

Step 2: Develop a vision of your Snapshot

Step 3: Map out your information needs

Step 4: Design your Snapshot

Step 5: Define additional data development
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Structure of this Activity Book
The remainder of this activity book will guide you through these steps. The purpose of each step is
first described, followed by specific activities for you to do in the Activity Worksheets that
accompanies this guide. This is available on the downloadable file section of:
www.demonstratingvalue.org/resources/demonstrating-value-workbook
We recommend working through this workbook with a cross-section of people in the organization.
You can do this in a workshop, a series of meetings or through targeted consultations.

Demonstrating Value’s philosophy about measurement and its guiding
framework
This guide (and all other Demonstrating Value tools) are based on the premise that the information
you gather in your organization has to be directly relevant to the decisions you make and be
compelling for others to learn about your value. To work out what information is most useful, always
keep the following simple question in mind:

'What do we want to know and show?'
In essence, you need to think about the story you want to tell and the decisions that can be better
supported by data.
Determining what information is useful is a big task, but it can be simplified by looking at it from a
few different perspectives shown in the lenses on the following pages. The first asks: ‘What
information is useful?' and the second asks ‘How will information be used?' The two lenses help
focus the answer, and are reflected in the exercises in this workbook.
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An Organizational Sustainability Perspective - What information can help you
understand whether you are developing and maintaining resources to meet your
purpose in the long run?
A Community Impact Perspective - What information can tell you about the
ability of the organization to successfully contribute towards the social, cultural
and environmental objectives set out in its mission?
A Business Performance Perspective - What information can tell you about the
success of the organization from a financial or ‘business’ perspective?
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It is also useful to consider carefully how information will be used, by considering three ‘audience’
perspectives:

An Operational Perspective - What information do you need to support day-to-day
decisions by management and staff? For instance, what can help you stay on top of
costs, quality, and delivery of your mission?
A Strategic Perspective - What information do you need to support strategic decisions
that are often made by a governance body such as a board? This information needs to
educate your audience about key trends and events that have occurred.
An Engagement and Accountability Perspective - What information do you need to
foster and maintain support of the organization? This includes support by investors,
community members, employees and beneficiaries of your mission. This audience may
have very limited knowledge of who you are and what you are trying to accomplish.
The data that you present will need context and interpretation.
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Step 1 Define your Audiences and their Needs
Your organization is important for many different groups of people, and in different ways. These
are your stakeholders. Understanding who these people are and what they care about, is critical for
developing effective monitoring and reporting capabilities. Common stakeholders include:
–
–
–
–
–
–
–
–
–

Employees
Volunteers
Management
A governance body (e.g. Board of Directors)
Constituent group – those in whose name you are working
Customers
Investors, funders, donors
Peers and partners
The community at large

Activity 1
Use Worksheet 1 to identify your stakeholders
and describe what information they need to do
their job effectively. Then assess how you can
better engage them.
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Step 2: Develop a Vision of your Snapshot
A Snapshot is a communication tool that you can use to present the performance and value of your
organization, program or project to boards, investors/funders and staff. It is tailored to your needs
and the audiences you want to connect with, and can take the form of an Infographic, Dashboard or
Impact Report.

This tool will give you a clear picture of your work to help you plan and manage your day-to-day
activities, demonstrate your value to others, and ensure the long-term sustainability of your
organization. Examples of Snapshots can be found at: www.demonstratingvalue.org/snapshots
Advantages of developing a snapshot include:
 Saving valuable time finding and pulling together data and other information for reports.
 Seeing key trends and relationships in data, so you can get the most from the data you
collect.
 Combining different types of information effectively to engage your audience.
The exact content and format of the Snapshot depends on who you want to reach and the issues that
are important. For example, the layout and content for a bi-monthly board presentation might be
very different from a Snapshot designed to be part of your public website to engage volunteers and
donors. The design process includes thinking about who the audience is, what decisions they are
making, the messages you want to convey, and the information you will present (which can include
numeric, narrative, pictures and other types of information).
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Types of Snapshots
Snapshots vary in terms of the visual elements that they include and how they balance text and
numerical information. Typical forms are Dashboards, Infographics and Impact Reports. Any of these
can be presented as a printed/PDF document or can be web-based.
Dashboard
A Dashboard displays indicators (also termed measures, metrics and data points) for an
organization, department, team or process. It is typically an internal tool that is directed to
management, a senior executive team or an advisory/governance board. Indicators are organized
around objectives and include key performance indicators (‘results’) and key success factors (‘what
drives the results’).
Infographic
An Infographic is a representation of information that is graphically designed to make data easily
understandable at a glance. It is mainly used as a communication tool to external audiences, often as
a small poster that can be displayed. The information is presented in a fun and eye-catching way.
Impact Report
An Impact Report may be a section of an annual report or a stand-alone report that clearly
communicates your mission and impact. The length can range from a few pages to more than a
dozen; you can go into more detail about your impact than in an Infographic. The information is still
presented in an eye-catching way with a balance of photographs, figures, metrics and text.
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Design Tools
A Snapshot can be designed with different tools
depending on your budget and needs. Once
you design a Snapshot, you can easily create
versions of it to suit other audiences. For instance,
a Snapshot that is developed for an Advisory
Board could later be adjusted to serve as a
public Snapshot, but changed to include less
detailed data more suitable to a public facing
document.
You can use a professional graphic designer to
create a Snapshot or design it yourself. There
are many software programs out there that
feature intuitive, drag-and-drop design features,
including office programs that you may already use, graphic design programs and interactive data
visualization / business intelligence solutions. These are described in more detail below. You can
start by designing something that is fairly basic and move to a more sophisticated design later on.
Like any effective communications tool, the substance of what you present is the most important, and
it may take a few iterations to develop a succinct and effective way to convey what you do, and
why it is important.
Office Software Suites
You likely already use programs like Microsoft Word, Excel, PowerPoint, or similar programs such
as Google Docs. These programs have built-in graphic design features that have become
increasingly sophisticated over time. You can also embed data in charts or link a figure in a Word or
PowerPoint file directly to data in spreadsheets. Some things to consider about this option:
 While there are some excellent design features in these programs, if you are not fully
familiar with them, they can be a little frustrating to use. Web tutorials are a good
place to learn. This guide also provides some tips.
 The file size can get quite large. Sometimes this affects the performance of the
program. It’s a good idea to close anything else that you may be working on.
 It is very easy to copy and paste parts of the Snapshot into other documents,
presentations and e-mails.
 The image quality will not be as sharp as other options, but they are still pretty good,
especially if any photos that you include are high resolution. You can save them as
PDF or as graphic files such as JPG and PNG.
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Graphic Design Software
There are many software solutions out there for designing, developing, and publishing graphical
content for web and print. While some of these are quite technical – such as solutions within Adobe’s
Creative Cloud like Adobe Illustrator – a number of them enable less skilled users to create graphic
design for infographics and reports using drag-and-drop features. Examples of the latter include
Piktochart, Venngage and Easelly. Most provide template themes. Some things to consider about
this option:
 These programs enable you to produce very high quality graphics.
 The drag-and-drop options have many infographic and report templates that provide
and excellent starting point.
 Most programs are cloud-based (you do not need to install them on your computer
and are instead accessible through a website). Some programs allow you to connect
with data in Google Drive and/or Dropbox
 In terms of the cost, many drag-and-drop solutions offer a ‘freemium’ payment model
which enables you do some basic creation for free, with a paid subscription for more
frills. Check for discounts for non-profits.
 The drag-and-drop programs and the companies associated with them are new and
the landscape is changing. Using a smaller vendor can carry some risk that they will
not stay in business.
Interactive Data Visualization / Business Intelligence Solutions
These programs produce dashboards that present data interactively: the reader can select and focus
in on specific data that are important. These programs also allow users to connect to many data
sources at the same time. Examples include Tableau, Clicdata, Zoho Analytics, Looker,
iDashboards, and Sisense. Some considerations:
 Many solutions are cloud-based and licensed monthly or annually. Some are
targetted to corporate clients, and as such, are pricey. Others are directed at smallerscale users. Many companies offer significant discounts to non-profits organizations for
basic versions of their product. A great place to check for discounts is with TechSoup
which connects charitable non-profits with donated and discounted technologies.
 A user can ‘slice and dice’ data, and test different assumption by manipulating input
parameters. This is useful when you have large datasets. Visualizing the data helps
users gain insights that they might not gain in other ways.
 Data connections can often be established in ‘real-time’, a helpful feature if you need
to see updates frequently.
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 The learning curve can be significant, but a user comfortable with databases or more
advanced features in spreadsheets can adapt to these programs easily. No
programming is required and design is simplified with a drag-and-drop interface.
 Many companies that offer these programs are start-ups and the landscape is
changing. Using a smaller vendor can carry some risk that they will not stay in business.

Activity 2
What kind of Snapshot would you like to develop? To get
ideas, look at Snapshot template designs and examples as
a starting point. You can see a number of snapshot
templates and examples on the DV website:
www.demonstratingvalue.org/snapshots
There are also many templates and examples available on
the websites associated with the drag-and-drop software
solutions described above, such as Piktochart, Easelly and
Tableau. You may also want to explore Dashboards,
Infographic and Impact Reports on-line in your field through
an internet search.
Once you have researched Snapshot Designs, fill in
Worksheet 2.
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Step 3 Define the Content of your Snapshot
In this step you will work out the content of your Snapshot. This focuses on identifying what you want
to convey in your snapshot, and then how you will convey it. All the information in the Snapshot
needs to support either a point you are making about your value (if the Snapshot’s purpose is to
engage a stakeholder), or an operational/ strategic decision. Let’s say you run a recycling
program, something that you may want to convey is:
We have been successful in increasing community participation in recycling.
You can then show this with some or all of the following content:




Tonnes of waste diverted
Change in recycling participation rates (% of households that use program/ households with
access to program)
Testimonials from those who never recycled before, but who are now recycling because of the
program.

Information can be numerical (quantitative indicators, measures and metrics). It can also be excerpts
from research, testimonials, narrative, images, short diagrams and other forms of information that can
be useful in supporting what you want to know and show. At this point, you don’t need to identify
the best information / indicators, just brainstorm ways that you can show this. Include both what you
currently collect and what you could in the future. You will have opportunity to refine this later.
Look at for suggestions about specific content for different aspects of community impact (by mission
areas), business performance and organizational sustainability in Appendix A: Snapshot Content
Ideas by Category. At this time, the following categories are included:
Community Impact











Cross Cutting
Supportive Employment
Transforming the Lives of Individuals
Culture
Health
Affordable Housing
Local Food
Land and Resource Stewardship
Green Economy
Re-use and Recycling

Business Performance
 Financial Performance
 Operations
 Sales and Marketing
Organizational Sustainability
 Human Capital
 Other Organizational Sustainability
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Other useful resources for identifying measures include:
KPI Library

Kpilibrary.com

Sustainable Development Goals Compass

https://sdgcompass.org (look for Business Indicators; The Tool
Search is also very useful).

Good Finance, Impact and Outcomes Matrix

https://www.goodfinance.org.uk/impact-matrix

Impact Reporting and Investment Standards (IRIS)

https://iris.thegiin.org/

Global Value Exchange Impact Toolkit

http://www.globalvaluexchange.org/

Urban Institute, Outcome Indicator Project

http://www.urban.org/policy-centers/cross-centerinitiatives/performance-managementmeasurement/projects/nonprofit-organizations/projectsfocused-nonprofit-organizations/outcome-indicators-project

ISO Standards (Sustainable Development Goals related)

https://www.iso.org/sdgs.html

Activity 3
Use Worksheet 3 to define the information that
could be included in your Snapshot based on your
organization’s mission and objectives. The
mapping starts with the big picture, by asking you
why you exists: your vision, mission and goals. It
then provides a simple way to pinpoint what may
be most important to know and show in your
organization, and to therefore include in your
Snapshot.
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Step 4. Design your Snapshot
In the previous step, you identified the information that is important for you to collect and
potentially show in a snapshot. You also identified a preliminary design in Step 2. You will now
put the two together in a draft snapshot by first refining the design and then combining the
design with content.

Refine the Design
Activity 4
Look at the Snapshot designs that you identified in
Worksheet 2 (d). Now develop your Snapshot
design more fully. Design it to fit you’re your
organizational branding using one of the design
tools described in the earlier section on Design
Tools.

Using the Demonstrating Value
Templates
The Demonstrating Value website includes a
number of different templates at
www.demonstratingvalue.org/snapshots.
Click on the name of the template to find the
downloadable files that include both the
template (DOCX) and instructions (in PDF with
yellow callout boxes contain suggestions for
how to personalize the template in Microsoft
Word). While the templates are designed in
Microsoft Word, these can also be edited in
Google Docs quite easily. Click on any part
of the image to edit in Google Docs’ drawing
tool.
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Graphic Design Tips
The following tips may help you to refine a design for your Snapshot that is visually effective,
and which will capture and hold the attention of others.
1. Keep it simple and uncluttered.
2. Limit your colour choices. Use colours that ‘go together’ (colour harmony). Pick colour
scheme based on your logo, or a key photo in the snapshot. There is more about is
below.
3. Limit the number of fonts to 2. Use contrasting fonts and stay away from frilly fonts.
Generally use serif for body, non-serif for heading.
4. Use white space effectively.
5. Use simple short text and keep it away from the edges.
6. Use an invisible grid (align sections and elements in the design).
7. Use borders, shadows, contrast and complementary colours to draw special attention to
something.
There are many great resources to learn more about design (like the Visual Learning Centre
https://blog.visme.co/). If you budget permits, you can turn to professional support to produce
something polished.
More about Colours
It is really hard to match colours with your eye. It is better to find the code (usually HEX or
RGB). If you don’t know it, you can use a web program. For instance, you can upload an image
to www.colorcodepicker.com and use the curser to move over your image to reveal the colour
codes.
Once you have identified your colour(s) you can set them up in your design program of choice.
HEX codes can be converted to RGB codes, and vis versa using web tools like www.rgbtohex.net.
If you want to identify additional colours in your Snapshot, you can find many ideas on-line, for
instance at: www.colorbook.io and www.color-hex.com, which show various colour palettes and
schemes and which can show you what colours work well with a colour that you already have.
If you think that you may print the Snapshot out in black and white, print drafts to see how they
look. Sections that stand out in colour may not standout in black or white. Adjust one of the
colour’s tint or shade to fix this.
Tips for Designing in Microsoft Word
Most people are familiar with this Microsoft Word, but may be less familiar with its graphic
design features which are quite robust. The availability of Microsoft Word makes it an easy first
step for designing snapshots. All design features are available across the Microsoft Suite of
Programs, such as PowerPoint and Excel.
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1. Use Text Boxes with a ‘Wrap Setting’ that is ‘In Front of the Text.’
This makes it much easier to move around and print. To do anything to a text box, including
editing text, you have to select it first with a mouse. When you do this, lines appear with square
boxes at the corners and half way points.

2. Set any other content that you add such as images and figures to ‘In Front of Text’ as
well. This makes it so you can easily move components of the Snapshot around on the
page.
3. Generally stay away from the ‘Smart Art’ feature. It makes the file size quite large and
can be challenging to manipulate. It is usually easier just to draw figures directly.
4. You can easily change the shapes of objects by using the ‘Change Shape’ feature under
the Format tab in the Drawing Tools Ribbon that appears when you select the shape.
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5. You can easily change the look of all of the content using the ‘Design’ tab on the
Ribbon. You can do this by selecting the Themes, Colour on the Design Tab. Colors,
Themes and Fonts are all customizable so that you can match your organization’s
branding.

Using these features, it was possible to change the look of the Simple Impact Report
template in less than 1 minute. Further refinements can then be made to font and colour
choices.
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6. Publish by saving as a PDF or creating an Image File. Saving or printing as a PDF is
possible in Word. While there is not easy way to save your file as an image within
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Word, you can use the Snipping Tool to select all or part of your Snapshot. This is a
desktop App on Windows. You can also use ‘Print Screen (PrtScr)’ on you keyboard and
then open and paste it into Paint, another desktop app. You can then crop and save the
image into the image file type that you prefer.

Define the Content
All snapshots can be divided into a number of different sections - a grouping of visual content
that supports a point that you want to demonstrate about your value. In the case of a
dashboard, this would be indicators that provide insight about and organizational objective. A
simple infographic will have only a few sections, while an impact report will have many.
Below is an example of an opening section in an Impact Report for a community dental clinic that
seeks to demonstrate the importance of the issue that the program is addressing:

Content could be developed directly or planned out in advance. The table on the next page
shows an example of how to plan the content in advance.
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Type of
content

Mix of figures, metrics and narrative.

What do you want to show in this
Section?
We address an important unmet
need in our community.

How will you represent this?
 A Headline that tells the reader that those who
need dental care the most are least likely to
receive it.
 Statistics drawn from research that show the extent
of the untreated dental needs.
 Figure that reinforces this point.
 Quote from a patient about situation before
coming to the clinic.

What makes good content?
For each section, think carefully about what you want to convey. Beware of presenting data for
the sake of presenting data! Rather group and relate information to make it meaningful. This
means thinking about:
 Decisions that the snapshot’s audience will be making.
 Clear messages you want to convey about your value
You can use figures, numbers, text, stories, and even multimedia like videos and photo, to convey
your message. Present it so that it can provide maximum insights to your audience. Consider
using data, figures and graphics that:
1. Grabs the reader's attention.
2. Accurately shows the facts.
3. Complements or demonstrates arguments.
4. Has a title, labels and units.
5. Is simple and uncluttered.
6. Clearly shows any trends or differences in the data.
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If you are using graphs, keep in mind that different types of graphs show different things (a line
graph shows trends, a bar chart highlights comparisons, a pie chart shows shares, etc.). An
excellent resource for how to effectively portray data in charts is Statistics Canada, “Using
Graphs” www.statcan.gc.ca/edu/power-pouvoir/ch9/using-utilisation/5214829-eng.htm

Activity 5: Develop your Snapshot
Once you have refined the Snapshot design you can
now develop the specific content of the sections. You
can do this directly in the Snapshot, or you can plan
this out in advance using Worksheet 4.
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Step 5: Define Additional Content Development
The snapshot which you have now developed is something that you can add to over time. In Step
3, you likely identified information that you would like to develop, but don’t have right now. In
this step, plan out what you would like to do in the future. It can be useful to think of this in
terms of:
 What is of most benefit to gather in the future? Consider this from the perspective of all
stakeholders who defined the information. Are there things that are logical to do first?
Are there things that would be nice to have, but are not critical?
 How much effort will it take to develop this data? Do you have a mechanism already in
place, or can you develop one easily? What are the time and skills required collect,
manage, and analyze the information? Will gathering these data be seen as intrusive by
participants? Are there language or literacy challenges? Are you trained in the method,
or will you need help from an outside consultant?
The following grid can help you prioritize and the box on the following page provides a
summary of common collection methods.
Collection Challenge
Easy
High
Importance of
Information

Medium

Low

Feasible

Difficult

3

2

2

Definitely
Collect

Worth
Collecting

Consider an
Alternative

2

1

1

Worth
Collecting

Collect if
have time

Collect if
have time

1
Collect if
have time

1
Collect if
have time

0
Ignore

Activity 6
Use Worksheet 5 to plan out how you can develop
additional data and evidence that will strengthen
your Snapshot.
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Collection Methods
The following list describes common methods to collect information
Activity Log
Staff report of daily activities.
Anecdotal records
Stories and narratives about an event, an experience, or an individual, described by staff or
participants.
Documentation
Administrative records of activities (e.g., inventory software, reports, minutes of meetings etc.).
Evaluation Form
A set of questions that determine the participants’ opinions, attitudes, and understanding once
an activity is complete.
Focus Group
Group discussions with a relatively small number of selected people about certain questions.
Interview
A set of questions (could be predetermined or not) about certain topics that are posed to a target
audience and followed by additional questions and conversations.
Journal Recording
Self report of daily activities by participants.
Knowledge/ Skill Tests
Survey
A set of predetermined questions about certain topics that are answered by a target audience.
A set of questions that determine the level of knowledge or skills in participants.
On-site visits
A combination of observation and interviews that occur in the participant’s environment.
Observation notes
Notes taken through direct observation of verbal and nonverbal behaviours that occur in activities.

This list is based on definitions in:
Zarinpoush, F. Project Evaluation Guide for Nonprofit Organizations: Fundamental Methods and Steps for Conducting
Project Evaluation. Toronto, Ontario: Imagine Canada, 2006.
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NOTES
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